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ORGANIZACJA EKRANU

Po uruchomieniu aplikacji Final Cut Express domyślna organizacja będzie wyglądać jak na obrazku poniżej.

 

Oczywiście do celu realizacji określonych zadań (np: importu materiału ze źródeł zewnętrznych, nagrywania 
podkładu dzwiękowego itd. program oferuje inne rozwiązania organizacji ekranu roboczego, można je 
znaleźć w menu Window -> Arrange). 
Na górze ekranu jest menu poleceń odnoszących się do całości programu, ale w większości podstawowych 
prac można je prawie całkowicie zignorować używając narzędzi i interfejsu okien + menu kontekstowego.
Podstawowe okna i palety robocze to:
Tool Palette w której znajdują się narzędzia pozwalające dokonywać selekcji, przycinania, zmiany wielkości, 
dzielenia ścieżek, modelowania kształtu krzywych itd.
Browser, w którym przechowuje się elementy projektu (filmy, grafiki, dźwięki,....) jak i sekwencje, z których 
się on składa (w zakładkach nazwanych tytułami projektów).
Canvas zwiera podgląd montowanego materiału / sekwencji (wyświetlanej w postaci warstw i ścieżek 
w odpowiedniej zakładce palety Timeline). W tym oknie możemu komponować finalną postać naszego 
materiału wideo.
Timeline gdzie widzimy techniczną konstrukcję warstw wideo i ścieżek audio sekwencji wyświetlanej 
w oknie Canvas. Tu możemu dokonywać selekcji, przycinać, regulować głośność czy transparentność.
Viewer w którym możemy podglądać i edytować fragment kopozycji czy też przygotować plik z biblioteki 
(Browser) przed umieszczeniem go w sekwencji. W tym też oknie w odpowiednich zakładkach można 
precyzyjnie (parametrycznie) regulować przemieszczanie (obrót, skalę,...) elementu graficznego/wideo 
w sekwencji, działanie nadaych na niego filtrów i efektow itd.
Zakładki Effects gdzie znajdują się filtry i efekty pozwalające zmieniać wygląd/brzmienie materiałów wideo 
i audio użytych w projekcie, jak również generatorów tworzących nowe elementy projektu (takie jak 
tytułówkę, proste elementy graficzne, plansze kontrolne itd.).
Stereofoniczy graficzny wskaźnik poziomu natężenia dźwięku (domyśnie ulokowany obok palety narzędzi) 
pozwoli określić bierzący sumaryczny poziom natężenia sygnału na ścieżkach audio.
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WYBÓR STANDARDU WIDEO

Zanim jednak rozpoczniemy właściwą pracę z programem należy zdecydować się w jakim standardzie 
chcemy uzyskać materiał. Należy ten krok wykonać przed rozpoczęciem jakichkolwiek działań 
kompozycyjnych. Późniejsza zmiana standardu może być problematyczna lub całkowiecie nieopłacalna 
(cała praca do zrobienia praktycznie od nowa). Po wybraniu docelowego standardu wideo, każda nowo 
utworzona sekwencja (File -> New -> Sequence) będzie tworzona w wybranym standardzie wideo.
W celu dokonania tej istotnej decyzji wybierz w menu Final Cut Express -> Easy Setup.

EASY SETUP

W oknie tym możesz zadecydować jakie chcesz od programu otrzymywać nowe sekwencje.
W tym celu w Format wybierz rodzinę standardów, które są potrzebne do realizacji projektu. Interesować 
będą Cię:
PAL - w tym standardzie oglądasz materiały emitowane w naszym kraju dla użytkowników odbiorników SD 
(ekran w proporcjach 4:3).
HD - materiały w wyższej rozdzielczości do oglądania na obiornikach HD i HD Ready (kadr ekranu 
panoramiczny 16:9).
NTSC - materiał w jakości SD przeznazone głównie na rynek północnoamerykański (nieprzydatne 
w Europie).
Następnie w Use będziesz mógł wybrać, dokładnie wyspecyfikowany standard materiału docelowego.
Środkowa część okna Easy Setup zajęta jest przez pole z opisem technicznym wybranego bieżąco 
standardu.
W celu zatwierdzenia swego wyboru kliknij w Setup.

ORGANIZACJA PLIKÓW, ROZPOCZĘCIE PRACY

Ze względu na wygodę pracy i możliwość wygodnego bakapowania projektu (np: celem przeniesienia na 
inne stanowisko). Warto przed rozpoczęciem pracy na poziomie Findera stworzyć czytelnie opisany folder, 
w którym przechowywane będą wszystkie składowe realizowanej pracy (zarówno pliki programu Final Cut 
Express jak i wszelkie składowe tworzonych w nim kompozycji takie jak materiały audio, wideo czy też 
nieruchome zdjęcia i grafiki).
Kiedy masz już tak przygotowany folder warto rozpocząć pracę od... pozamykania wyszystkich aktualnie 
otwartych, a nieużywanych projektów (program Final Cut ma zwyczaj na starcie ładować wszystkie ostatnio 
używane projekty, których użytkownik nie zamknął przed wyłączeniem aplikacji w poprzedniej sesji pracy). 
Uczynisz to poleceniem z menu File -> Close Project.
Teraz już możesz porzez File -> New Project utworzyć swój nowy projekt. Zwróć uwagę, że powstały w ten 
sposób projekt zawiera od razu jedną pustą, gotową do pracy sekwencję (Sequence 1) w wybranym przez 
Ciebie standardzie wideo. Wprawdzie Twój projekt jeszcze niczego nie zawiera, ale to dobry moment by go 
po raz pierwszy zapisać (File -> Save Project As...) we wcześniej utworzonym folderze. Zwróć uwagę, że 
jego zakładka w oknie Browser zmieniła swój opis na nazwę, którą nadałeś zapisywanemu plikowi. Jego 
zapisanie pozwoli też na poprawną pracę systemu tworzącego automatycznie (domyślnie co 30 minut) 
kopie zapasowe Twojej pracy.

SKŁADOWE PROJEKTU

Twoje praca może się składać z elementów wizualnych i dźwiękowych, które pobierzesz z dysku (najlepiej 
wcześniej umieszczając je w uprzednio utworzonym folderze) w postaci gotowych plików, z źródeł 
zewnętrznych takich jak kamera, czy magnetowid lub też wygenerujesz bezpośrednio w programie Final 
Cut (np: plansze kontrolne czy elementy opisów tekstowych/tytułówki).

Apple Final Cut Express 4 QuickStart © Jakub Balicki 2010          strona 3



IMPORTOWANIE PLIKÓW Z DYSKU

W celu załadowania do projektu plików graficzych, dźwięków czy filmów wystarczy wybrać w menu File -> 
Import -> Files... i wskazać plik/i potrzebne do załadowania (poleceniem File -> Import -> Folder... można 
ładować zawartość całych folderów bez potrzeby wskazywania po kolei ich zwartości).

Po wskazaniu pliku przez kliknięcie (plików w grupie przez zaznaczenie z Shiftem, lub pojedyńczych plików 
przez klikanie z Commandem) naciśnij Choose i wybrane pliki pojawią się w palecie Browser w zakładce 
podpisanej nazwą bieżącego projektu.

Zwróć uwagę, że załadowane pliki graficzne miewają dwa typy ikonek:
Wycinek klatki z taśmy filmowej z literami ABC sugeruje zawartość graficzną, statyczną i pozbawioną 
warstw. Przykładowo pliki JPEG czy TIFF nie zawierające warstw czy kanału Alpha (przezroczystości) lub 
też pliki jednowarstwowe z Alpha w formacie PNG.

Jednak w wypadku załadowania pliku Photoshopa (.PSD) otrzymuje on ikonkę analogiczną jak sekwencja.

UWAGA!
Final Cut nie informuje czy plik nadaje się do użytku. W wypadku plików o zbyt dużej rozdzielczości, często 
je ładuje pokazując je jednak jako czarną płaszczyznę (w okine Canvas). Jedyną drogą jest wtedy redukcja 
rozdzielczości (np: w Photoshopie) i ponowny import fo FCE. Podobnie problematyczne mogą być pliki 
w przestrzeni barw innej niż RGB. Przykładowo pliki CMYK zazwyczaj ładują się do programu, jednak ich 
wygląd może mocno odbiegać od tego co stworzyłeś w Photoshopie czy Illustratorze. Lepiej w programie, 
w którym powstały przerobić je na RGB i zaimportować ponownie.
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PLIKI PSD JAKO SEKWENCJE

Po zaimportowaniu plików Adobe Photoshopa (.PSD) autmatycznie stają się one skwencjami. Jest to 
stosunkowo łatwa droga do szybkiego budowania animacji czy infografiki. Wystarczy w Photoshopie (lub 
innym programie operującym na warstwach i zapisujących pliki PSD w przestrzeni barw RGB) przygotować 
materiały tak, by każdy element przeznaczony do niezależnej animacji znajdował się na osobnej warstwie.
Po zaimportowaniu do Final Cut-a wystarczy kilknąć dwukrotnie na taki plik w oknie Browser, a otworzy się 
on automatycznie w oknie Timeline jako sekwencja wyglądająca przykładowo tak jak poniżej.

Teraz pozostaje jedynie poruszyć, skalować czy obracać elementy na poszczególnych warstwach 
(jednocześnie dodając klatki kluczowe) i już powstaje gotowa animacja.

PLIKI WIDEO

Oczywiście najbardziej logicznym typem plików, które importuje się do FCE są materiały wideo lub 
audowideo. Final Cut jest w stanie zaimportować w praktyce prawie wszystkie typy plików jakie otwierają 
się w QuickTime Playerze (problematyczne bywają niektóre typy plików MPG czy DIVX-ów). Pamiętaj 
jednakże, że do QuickTime można doinstalowywać różne kodeki i nie koniecznie jeżeli jakiś plik w Twoim 
domowym komputerze działa lub nie działa w QuickTime; to wcale to nie oznacza, że analogiczna sytuacja 
nastąpi w pracowni.
Po zaimportowaniu ikonki plików wideo wyglądają w oknie Browser następująco.

Zaimportowane w tym przykładzie pliki różnią się między sobą między innymi tym iż w gornym 
(text-red-alpha) zawarty jest też kanał Alpha. Na podstawie ikonek jednak tego niezauważymy. Jedyne 
wrzucenie pliku do okna z podglądem materiału (np: okna Viewer) lub kliknięcie prawym klawiszem na 
obiekcie i wybranie w menu kontekstowym: Item Properities... pozwoli nam to sprawdzić.
Przykładowo po zastosowaniu tego ostatniego w okienku Item Properities: wideo-animacja w zakładce 
Format dowiadujemy się, że dany materiał jest pozbawiony kanału przezroczystości (lub jest on 
ignorowany).

Po kliknięciu na pliku text-red-alpha informacja jest odmienna.

A jeżeli w w/w plik kiliknie się dwukrotnie zostanie on otworzony 
w oknie Viewer i wygląda następująco (zwróć uwagę na szarą 
szachownicę informującą o przezroczystości analogicznie jak 
np: w programie Adobe Photoshop) jak na obrazku po prawej
stronie.
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miejsce do wpisania
etykiety i informacji
o klipie przeznaczonym 
do przechwycenia 
(poniżej można rozwinąć
podobną w zastosowaniu 
zakładkę Markers)

ilość wolnego miejsca na dysku
i przewidywana (w minutach) ilość 
materiału jaka się na niego zmieści

czas selekcji/klipu

zaznacza początek klipu i jego koniec

aktualny czas na taśmie

przyciski importu materiału

“monitor” podgląd sygnału z kamery

“pokrętła” i “przyciski” służące do odtwarzania, przewijania, 
pauzowania materiału (jeżeli tylko nasze urządzenie jest w pełni
zgodne z FCE zastępują nam one całkowicie fizyczne przyciski
z obudowy powyższego urządzenia)

IMPORT WIDEO Z NOŚNIKÓW TAŚMOWYCH

W większości nowych urządzeń rejestrujących obraz i dźwięk przeznaczonych dla użytkowników 
konsumenckich i semipro przeważają rozwiązania zapisujące dane na karcie pamięci, dysku twardym, czy 
płycie CD/DVD/BR. Powoduje stosunkowo łatwą dostępność do przechowywanych tam danych, zazwyczaj 
praktycznie na poziomie drag and drop. Jednakże w wypadku urządzeń wykorzystujących napędy taśmowe 
(i możliwe, że co gorsza analogowe) - sprawa się trochę komplikuje.
Zacznijmy od wariantu najprostrzego.

IMPORT Z KAMERY DV/miniDV

Posiadanym urządzeniem jest kamera/magnetowid w standardzie DV/miniDV podpięta do komputera
do portu IE1394/FireWire. Jeżeli kamera jest w pełni zgodna z FCE wystarczy uruchomić kamerę, 
przełączyć ją w tryb magnetowidu i najlepiej dopiero w tym momencie uruchomić program Final Cut.
Można już z menu File wybrać polecenie Capture... po chwili powinno pojawić się okno jak na obrazku 
poniżej.

Teraz możesz używając “pokręteł” i “przycisków” w dolnej części okna odtwarzać, pauzować, przewijać 
taśmę w urządzeniu aby odnaleźć początek i koniec klipu, który chcesz zaimportować. Jest to o tyle 
istotne, ze zapewne chcesz wykorzystać część z ujęć zarejestrowanych na taśmie, a nie wszystkie. Nie ma 
więc powodu by importować całą 45 minutową, a może 2 godzinną taśmę dla np: kilku paruminutowych 
klipów. Gdy znajdziesz początek takiej potrzebnej Ci sekwencji zaznaczasz go klikając w przycisk Mark In 
w dolnym lewym rogu okna (wskazany na obrazku strzałką). A następnie poszukujesz końca w/w klipu 
i zaznaczasz przyciskiem Mark Out. Teraz możesz też wypełnić (w prawym górnym rogu okna) tabelki 
z informacją, która zostanie przypisana do tego ujęcia. Teraz pozostaje cofnąć materiał do początku 
zaznaczonego ujęcia (przycisk Go to In Point w leweym dolnym rogu okna) kliknąć przycisk Clip (w części 
Capture w prawym dolnym rogu okna).
Program zapyta się po raz ostatni o nazwę i ewentualne
adnotacje do importowanego kawałka materiału
(obrazek po prawej) i dalej wszystko winno nastąpić 
atomatycznie, aż do momentu gdy w oknie Browser
zobaczymy ikonkę zaimportowanego klipu, a wygląd 
ekranu powróci do stanu początkowego z przed
kliknięcia w Clip.
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Kilka uwag. Jeżeli pracujesz z urządzeniem edycyjnym to poziome “pokrętło” z lewej i “slider” z prawej mają 
prawo dawać Ci wysoki komfort pracy przewijając po jednej lub więcej ramce w tył i przód. Jeżeli jednak 
pracujesz z magnetowidem nieedycyjnym lub po prostu z kamerą, jego/jej reakcja na polecenie przewijania 
poklatkowego (szczególnie w tył) może nie być (delikatnie mówiąc) zbyt płynna i natychmiastowa. 
W dodatku częste korzystanie w z tej opcji nie wydłuży żywotności jej mechanizmu. W tej sytuacji lepiej 
zaznaczyć zakres klipu przeznaczonego do importu zgrubnie, z pewnym zapasem na początku i końcu. 
Kiedy klip już będzie na dysku bez problemu przytniesz go precyzyjniej i szybciej zamiast “nękać” 
mechanizm napędu taśmowego.

IMPORT Z NOŚNIKÓW ANALOGOWYCH 

W wypadku gdy musimy zaimportować wideo ze źródeł (jak np: tuner TV) czy nośników (kamery czy 
magnetowidy) analogowych niezbędne będzie nam urządzenie pozwalające na konwersję analogowego 
audio i wideo na sygnał cyfrowy. Nalepiej dysponować jakimś konwerterem A -> D podpiętym do portu 
IE1394/FireWire i rozpoznawanym jako kamera/magnetowid. Niektóre takie konwertery pozwalają również 
sterować kamerą/magnetowidem analogowym poprzez złącze LANC. Wtedy praca z takim urządzeniem 
jest bardzo zbliżona do opisanej w poprzedniej części (przechwytywanie z urządzeń DV/miniDV). Jednak 
gdy urządzenie którym dysponujesz nie posiada LANC-a (niestety sytuacja znacznie popularniejsza 
w praktyce ze sprzętem konsumenckim) proces importu materiału wymaga znacznie więcej zaangażowania 
z Twojej strony. Najpierw warto przejrzeć taśmę i wynotować czas początków i końców interesujących Cię 
kawałków materiału. Następnie wracasz do początku pierwszego z klipów albo lepiej 
kilkanście/kilkadziesiąt sekund wcześniej. Naciskasz Play na kamerze/magnetowidzie Gdy obraz 
w “monitorze” podglądu się ustabilizuje, klikasz w prawym dolnym rogu okna w części Capture w przycisk 
Now*. Zazwyczaj mija kolejnych kilka czy kilkanaście sekund zanim rozpocznie się proces przechwytywania 
(widoczne okno z podglądem na środku ekranu). Nie przejmuj się jeżeli obraz w w/w oknie nie jest zbyt 
płynny i opóźnia się w stosunku do materiału z kamery/magnetowidu. To normalna sytuacja i nie wpłynie 
ona na jakość przechwyconego klipu. Gdy w oknie podglądu na komputerze 
(a nie w ekraniku/wizjerze kamery czy w podłączonym do niej monitorze podglądowym) zobaczysz, że cały 
potrzebny klip już się odtworzył, przerywasz proces przechwytywania naciskając na klawiaturze przycisk 
ESC. W magnetowidzie/kamerze naciskasz Stop lub Pausę. Jeżeli masz na taśmie następny klip do 
zaimportowania, to przewijasz taśmę do początku kolejnego klipu i powtarzasz całą procedurę od nowa.

*) W wypadku niektórch urządzeń nie zawsze wyłapują one automatycznie początek sygnału i trzeba je 
poinformować o tym ręcznie naciskając przycisk na obudowie lub przycisk Play pod “monitorem podglądu” 
w oknie Capture w programie FCE. Czasami nawet trzeba w/w Play kliknąć kilkakrotnie (z zachowaniem 
minimum 5-cio sekundowych przerw). Powyższe szczególnie istotne z wieloma produktami Dazzle i 
Canopusami.

IMPORT PLIKÓW AUDIO

Import plików zawierających dźwięk odbywa się analogicznie 
poprzez polecenie File -> Files... Jak widać na obrazku obok FCE 
przyjmuje większość popularnych typów materiałów audio. 
Jednakże biorąc pod uwagę jakość, raczej warto w miarę możliwości 
zrezygnować z plików z kompresją stratną (takich jak np: MP3) 
na rzecz tych samych źródeł w plikach z kompresją bezstratną, lub 
niekompresowanych (np: AIFF z Linear PCM).
Pliki audio reprezentowane są w oknie Browser za pomocą
ikony głośnika.

OKNO VIEWER

Materiały zawarte w oknie Browser, z których powstanie w przyszłości projekt wideo można wstępnie 
przeglądać, przycinać, poddawać działaniu filtrów itd. jeszcze przed dodaniem do sekwencji. W wypadku 
większości z nich wystarczy dwukrotnie kliknąć na ich ikonce w palecie Browser by po chwili zobaczyć ich 
zawartość w palecie Viewer. Wyjątkiem od tej reguły są sekwencje i pliki PSD, które po zaimportowaniu 
zostały uznane przez FCE za sekwencję. Te typy materiałów w celu otworzenia w Viewerze wystarczy na 
niego przeciągnąć (z oka Browser czy Timeline) do zakładki opisanej Video lub Mono lub Stereo  (nazwa tej 
zakładki zmienia się w zależności od typu ostatnio przeglądanego pliku, przy czym przy nazwach Mono 
i Stereo w nawiasie może pojawić się alfanumeryczny opis standardu). Ponieważ nazwa zakładki zmienia 
się automatycznie można np: na dzwiękowe Mono naciągnąć plik wideo czy zdjęcie i na odwrót.
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“pokrętła” i “przyciski” służące do odtwarzania, przewijania, pauzowania materiału 

marginesy tracone w emisji

obszar bezpieczny akcji

obszar bezpieczny tytułówki

podgląd materiału
wideo/grafiki

przyciski znaczników In i Out

przycisk dodania znacznika

przycisk dodania 
klatki kluczowej

skocz do poprzedniego elementu skocz do następnego elementu

odtwarzaj

odtwarzaj pomiędzy znacznikami In i Out odtwarzaj okolicę bieżącej klatki

wirtualna głowica
magnetowidu, wskazuje

umiejscowienie czasowe
wyświetlanej klatki

lista ostatnio używanych elementów

znacznik Out

wirtualna taśma wideo

znacznik In

lista generatorów
gotowych obiektów

zaznaczony 
(wyświetlany
w sekwencji) fragment
materiału

lista wyświetlanych
elementów:
- sam obraz
- obraz i obwiednia
- informacje czasowe
- obszary bezpieczne

zakładka obrazu

zakładki ścieżki dźwiękowej zakładka kontroli filtrów

zakładka kontrolująca przemieszczanie, skalowanie, 
transparentność, itd. materiału w sekwencji, w której jest użyty

czas selekcji/klipu

wybór powiększenia
obrazu w oknie

(a na dole korekta
proporcji dla pikseli

kwadrtowych
i prostokątnych)

czas wyświetlanej
klatki

W zależności od przeciągniętego na okno Viewer materiału może ono mieć mniej lub więcej dodatkowych 
zakładek pozwalająć kontrolować i zmieniać zawartość przeciągniętego pliku, jak i jego zachowanie 
w sekwencji.

Zazwyczaj pracę z nowym elementem audio lub wideo zaczyna się od jego przejrzenia (kontroli 
merytorycznej i technicznej), a następnie zaznacza się (przyciski znaczników In i Out) zakres, który chcemy 
umiejscowić w sekwencji. Następnie przeciągamy go (chwytając za środek kadru) bezpośrednio na 
odpowiednie miejsce (w czasie i w strukturze warstw) w palecie Timeline lub do okna Canvas (gdy 
naciągniemy go na to okno pojawią się dodatkowe drop zony określające co stanie się z dodawanym 
kawałkiem materiału).
W wypadku materiałów audio nie ma oczywiście podglądu, więc by je przeciągać z Viewera na Timaline 
chwytamy za ikonę ręki trzymającej symbol głośnika.
Ponieważ przyciski kontroli odtwarzania i przewijania (jakie znajdziemy w oknach Viewer, Canvas i Capture) 
są trochę inne niż w popularnych plajerach wideo ich działanie opisane jest na poniższym obrazku.
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czas wyświetlanej próbki

znacznik Out

listwa czasu

czas selekcji

znacznik In

punkt węzłowy

krzywa balansu
krzywa wzmocnieniawaveform audio

balans (różnica natężenia między kanałami)

wzmocnienie dźwięku
Reset, niweluje wprowadzone zmiany

przeciągnij za tą ikonę by przenieść
materiał audio na Timeline
(w zakresie selekcji In/Out)

ZAKŁADKI MONO/STEREO

W wypadku dźwięku, jest on w swojej zakładce reprezentowany jako waveform (czyli graficzny diagram 
ilustrujący natężenie sygnału w stosunku do upływającego czasu). Dodatkowo na w/w diagramie widzimy 
dwie linie (różową) informującą o wzmocnieniu i fioletową określającą balans pomiędzy kanałami. Można je 
regulować orzeciągając za nie kursorem (oczywiście narzędziemi z np: grupy pióro możemy dodawać, 
przemieszcześ i kasować węzły modelujące kształt krzywych i będące jednocześnie klatkiami kluczowymi). 
Podobnie można dokonywać regulacji w/w parametrów odręcznie, ciągnąc za suwaki w odpowiednich 
kolorach opisane Level i Pan lub wpisując parametr numerycznie w okienku na prawo od odpowiedniego 
suwaka. By wyzerować wszystkie wprowadzone zmiany mamy do dyspozycji przycisk Reset (z czerwonym 
X). Do przeniesienia materiału na Timeline służy ikona dłoni z symbolem głośnika.

LICZNIKI CZASU

Jak zapewne już zauważyłeś notacja upływu czasu używana w programie jest zgodna z SMPTE
i pary cyfr oddzielone dwukropkami informują o numerze:  godziny   :   minuty   :   sekundy   :   klatki.
Zwróć uwagę, że projekt nie musi wcale zaczynać się od 00:00:00:00 gdyż może być np: jedynie częścią 
większej całości.
W liczniku sekundy i minuty liczone są od 0 do 59, natomiast klatki od 0 do 24 (PAL) lub 29 (NTSC).

SPECYFICZNE ELEMENTY OBSŁUGOWE OKNA

Zapewne u dołu zakładki Mono/Stereo (nad listwą z przycikami i pokrętłami) widoczny był dość dziwny 
pasek przewijania zawartości okna (gdzy ciągniesz za kończące go uchwyty, jednocześnie skalujesz 
zawartość/powiększenie w oknie), oraz umiejscowiony na lewo od niego suwak “z kreseczami” - 
specyficzne dla tego programu rozwiązanie również przeznaczone do skalowania zawartości okna. 
Oba te rozwiązania napotkasz ponownie w onie Timeline, zakładce Motion i wielu innych miejscach.
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zeruje wszystkie parametry do wartości domyślnej

określa jakich parametrów klucze widziane są na podstawowej belce czasu
podstawowa belka czasu

daje możliwość dostępu
do precyzyjnych nastaw
działania filtru

okno z wartością numeryczną

suwak regulacyjny

nazwa parametru

przyciski pozwalające
zapróbkować wartość
parametru

włącznik działania filtru

skocz do poprzedniego klucza skocz do następnego klucza

krzywa parametru

punkty węzłowe

punkt korekcyjny (zaczep/uchwyt przemie-
szczając go zmieniasz ugięcie krzywej)

belka czasu pozbawiona możliwości 
regulacji krzywej natężenia parametru

Dodaj/Usuń klucz

ZAKŁADKA FILTERS

Jeżeli chcemy w jaskiś sposób zmienić wygląd obrazu czy brzmienie dźwięku w klipie. Zazwyczaj 
wykorzystuje się do tego filtry (są one do znalezienia w oknie Browser w zakładce Effects, lub też
w menu Effects u góry ekranu). Szczególnie wygodnie pracuje się z nimi przeciągając ich (filtrów) ikonki
z zakładki Effects bezpośrednio na okna Canvas, Viewer (zarówno na obraz podglądu jak i do zakładki 
Filters), oraz na reprezentanty klipów w oknie Timeline.

W wyniku takiego działania mamy nadany na materiał filtr działający na całej jego czasowej rozpiętości 
z jednakowym (domyślnym) natężeniem swoich parametrów. Teraz korzystając z zakładki Filters w oknie 
Viewer możemy zmodyfikować owe parametry, co więcej można tę modyfikację zróżnicować w czasie 
dodając klatki kluczowe określające konkretne stany natężenie danego efektu. W tym celu należy upewnić 
się czy w oknie Viewer mamy odpowiedni klip (jeżeli nie to przeciągnij jego reprezentanta z Timeline, na 
otwartą zakładkę Video lub Mono/Stereo). Następnie w zakładce Filters w wybranym filtrze możesz 
dodawać klatki kluczowe bądź to przyciskiem dodaj/usuń klucz, lub też narzędziami z grupy Piórko 
i regulować natężenie parametrów: odręcznie suwakami lub przeciągając ścieżkę parametru czy 
umiejscowione na niej punkty węzłowe; parametrycznie w okienkach z wartością numeryczną.
Zwróć uwagę, że filtry w oknie Filters można przeciągać przemieszczając je w górę lub w dół w hierarchii.
Ma to wpływ na kolejność ich zastosowania i w wyniku tego często na finalny efekt.
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Jeżeli pracowałeś wcześniej na programie takim jak np: Adobe Photoshop to pamiętasz zapewne, że filtry 
zmieniały obrabiany fragment grafiki. Kidy zapisałeś plik i w następnej sesji pracy otworzyłeś go ponownie, 
efektu działania filtru raczej nie można już było w łatwy sposób usunąć. W przeciwieństwie do tej metody 
w programie Final Cut żaden nadany na materiał filtr nie jest na nim zastosowany w sposób trwały. 
Wszystkie są nadawane dynamicznie i w każdym momencie pracy można bezstratnie przeregulować ich 
parametry (za każdym razem efekt generowany jest na podstawie nienaruszonego materiału z pliku 
wzorcowego), lub też wyłączyć w 100% przywracając oryginalną postać. Dotyczy to również wszelkich 
innych operacji takich jak: przycinanie, przyśpieszanie, zwalnianie materiału, jego przemieszczanie, 
obracanie, skalowanie, deformowanie, kadowanie itp. Wszystko to jest w pełni odwracalne. Szczególnie 
warto o tym fakcie pamiętać gdy polecenie Undo staje się szare (nieaktywne).

ZAKŁADKA MOTION

Występuje ona wyłącznie przy materiałach wizualnych i audiowizualnych. Pozwala na kontrolowanie tego co 
w sensie wizualnym dzieje się z zawartością klipu. Wszystkie jego cechy (z wyłączeniem Motion Blura) 
można kontrolować kluczując, jak i w większości wypadków modelując kształt krzywej parametru. 
Oczywiście to co parametrycznie w zakładce Motion zrobimy np: zmieniając parametr nachylenia czy skali 
można zrobić bezpośrednio w oknie Canvas (a często i w Viewerze w zakładce Video) odpowiednimi 
narzędziami (np: w wypadku przytaczanych powyżej zmian używając narzędzia Strzałka / Selection Tool 
i obwiedni / boundingboxu).

Basic Motion pozwala kontrolować (parametry od góry) 
rozmiar, nachylenie, położenie w kadrze i punkt odniesienia 
względem którego dokonywane są powyższe operacje 
(domyślnie jest to środek obiektu). Zwróć uwagę, że 
nachylenie może przyjmować wartości ujemne i dodatnie 
znacznie przekraczające 360 stopni. Pozwala to określić 
ilukrotnie i w jaką stronę obiekt się obróci (stąd na 
wskażniku dwie wskazówki: duża czarna do zakresu 0-360 
i mała czerwona do wielokrotności. Większość tych 
operacji można wykonać narzędziem Strzałka  i obwiednią.
W wypadku skalowania domyślnie operacja jest 
proporcjonalna, dopiero wciśnięcie Shift powoduje utratę 
proporcji.

Crop określa przycięcie (kadrowanie) obrazu (z lewej, 
prawej, od góry i dołu) jak i zmiękczenie krawędzi kadru.
Analogicznie można to robić (oprócz zmiękczenia) 
narzędziem Crop Tool (gdy przytrzymamy klawisz 
Command operacja dotyczy obu boków równocześnie).

Distort pozwala na perspektywiczną deformację obrazu 
(pierwsze cztery parametry określają przemieszczenie 
narożników obwiedni, ostatni stosunek proporcji boków 
pionowych i poziomych). Analogicznie działa Distort Tool 
(praca z wciśniętym Shiftem przemieszcza proporcjonalnie 
parę narożników).

Opacity określa transparentność (przezroczystość) obrazu.
Można to samo uzyskać przy użyciu Strzałki i narzędzi 
grupy Piórko modelując kształt krzywej krycia na 
reprezentancie klipu w palecie Timeline.

Drop Shadow generuje cień. Można kontrolować jego 
przesunięcie, nachylenie, barwę, zmiękczenie krawędzi, 
oraz natężenie (transparentność).
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Motion Blur jest rozwiązaniem naśladującym efekt który znamy z urządzeń rejestrujących obraz. 
Mianowićie gdy w kadrze znajduje się szybko poruszający obiekt, to jego kształt zazwyczaj rozmazuje się 
(zależne jest to od czasu ekspozycji) wzdłóż jego faktycznej lub pozornej (przemieszczeniu uległa kamera) 
trajektorii ruchu. Jeżeli więc chcemy wprawić w szybki ruch obiekt np: wycięty z nieruchomego ujęcia. 
Warto go owym Motion Blurem “rozmazać” celem uzyskania bardziej naturalnego wrażenia. Pozwala to 
często kryć też niedoskonałości takiej prostej kompozycji obrazu. W sekcji Motion Blur znajdują się dwa 
parametry. % Blur określa długość “rozmazania”, zaś Samples liczbę transparentnych kopii obiektu, 
z którego jest ono budowane. Przy nastawie 1 efekt nie występuje. Im większa liczba próbek tym bardziej 
realistyczny efekt... ale uwaga, jest to rozwiązanie bardzo spowalniające renderig.

OKNO CANVAS

W tym właśnie miejscu widzisz podgląd właściwej, budowanej przez Ciebie kompozycji wideo. To co tam 
widzisz będzie finalnym efektem Twojej pracy... ale z jednej strony ów podgląd wiele mówi Ci o tym co 
dotrze jako obraz do klienta/widza/odbiorcy, z drugiej jednak strony nie należy mu nadmiernie ufać.
Po pierwsze jeżeli do obejrzenia materiału nie został on przeliczony (menu Sequence -> Render...) to może 
być wyświetlany w uproszczonej formie (zależnej od nastaw w Twojej kopii programu, jak i mocy stanowiska 
przy którym pracujesz). Kolejnym problemem jest kompresja. Większość materiałów cyfrowego wideo 
i audio do celów dystrybucyjnych jest poddawana kompresji stratnej (co znaczy, że traci się część 
informacji obrazowej i dźwiękowej by zmniejszyć rozmiar pliku). Ten sam film przepakowany na płytę 
BlueRay HD i skompresowany na potrzeby np: internetowego portalu dla użytkowników telefonii 
komórkowej może się drastycznie różnić. O tym jaka będzie zastosowana decydujesz wybierając polecenie 
File -> Export -> Using QuickTime Conversion... lub korzystając z zewnętrznego programu 
enkodującego/masterującego. Kolejną płapką bywa różnica w specyfice dystrybucji z użyciem cyfrowych 
i analogowych rozwiązań telewizyjnych. To co się stanie (szczególnie w TV analogowej) z jasnością i barwą 
obrazu najlepiej śledzić nie na monitorze komputera, a na zewnętrznym monitorze podglądowym, 
przypiętym do stanowiska poprzez kartę lub zewnętrzny konwerter cyfrowo - analogowy.
Okno Canvas (analogicznie jak Timeline) może mieć wiele zakładek opisanych nazwami skwencji. Gdy 
w jednym z tych okien klikamy w którąś z zakładek by była ona tą “na wierzchu”, analogiczna zmiana 
następuje w drugim oknie. Dodatkowo w nagłówku w/w okien możemy zobaczyć adnotację Canvas: (lub 
Timeline:) Sequence 4 in Project 2 co informuje o tym którą sekwencję i z jakiego projektu (każdy projekt to 
osobny plik) widzimy, gdyż może się zdarzyć, że mamy w różnych jednocześnie otwartych projektach 
sekwencje o identycznych nazwach.
O ile przyciski, pokrętła, liczniki timecodów itp. w wypadku okna Canvas, są w większości bliźniaczo 
podobne do rozwiązań z okna Viewer i nie będę ich tu ponownie opisywał, to jednakże można tu znaleźć 
pewną ilość elemantów specyficznch (np: dropzony montażowe), jak również całą grupę alertów i informacji 
wyświetlanych na elementach projektu.

SZYBKI MONTAŻ Z UŻYCIEM DROPZONÓW

Aby jak najprościej rozpocząć montaż materiału wideo wystarczy przeciągać klipy z okna Browser 
bezpośrednio na okno Canvas. Gdy uczynimy taką operację, a kursor znajdzie się nad oknem Canvas, to 
po jego prawej połowie pojawią się ikonki z podpisami. Lewa połowa okna pozostanie pusta i gdy w niej 
upuścimy przenoszone klipy to na Timelinie zaczną się one układać jeden za drugim. Jeżeli jednak 
zaczniemy je upuszczać na strefy montażowe (dropzony) wtedy będą następowały bardziej złożone zdarzenia.

Insert dodaje klip za głowicą (pozycją wirtualnej głowicy magnetowidu w oknie Timeline). Jeżeli głowica jest 
pomiędzy klipami, to nowowstawiony je rozsunie. Jeżeli kursor jest w środku klipu, to klip zostanie rozcięty 
i rozsunięty by w środku umieścić nowy materiał.

Insert with Transition analogicznie jak powyższe, jednocześnie dodając przejście typu Cross Dissolve 
pomiędzy klipem poprzedzającym, a nowo wrzucanym.

Overwrite zasłania klip na prawo od głowicy nowym materiałem. Jeżeli nowy klip jest krótszy to nie 
zasłania on całości poprzedniego, jeżeli dłuższy, to zasłania poprzednika jak i kolejne klipy na prawo od 
głowicy.

Insert with Transition analogicznie jak powyższe, jednocześnie dodając przejście typu Cross Dissolve 
pomiędzy klipem na lewo od głowicy, a nowo wrzucanym.
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znacznik In
(początku selekcji
materiału do eksportu
lub do przeniesienia
do innej sekwencji)

pierwsza klatka
klipu w sekwencji

ostatnia klatka
klipu w sekwencji

fizyczny
początek 
materiału

fizyczny
koniec 

materiału

koniec 
sekwencji

znacznik Out
(końca selekcji

materiału do eksportu
lub do przeniesienia
do innej sekwencji)

znacznik warstwy docelowej

przycisk z nazwą warstwy

przycisk z nazwą warstwy

Replace zastępuje klip na prawo od głowicy nowowrzucanym. Wymaga 
materiału o czasie trwania identycznym lub dłuższym niż zastępowany. 
Jeżeli materiał jest zbyt krótki, otrzymamy komunikat o błędzie. Jeżeli jest 
dłuższy to zostanie automatycznie docięty do długości klipu 
zastępowanego.

Fit to Fill zastępuje plik na prawo od pozycji głowicy nowowrzucanym, lecz 
nowy klip nie jest przycinany, lecz poprzez regulację prędkości 
dopasowywany w miejsce po poprzedniku.

Superimpose działa podobnie jak Replace lecz oryginalny klip pozostaje 
nienaruszony, zaś nowy zostaje umieszczony na warstwie powyżej 
i docięty do czasu trwania poprzednika. Oczywiście nowy klip musi mieć 
czas trwania minimum jednakowy jak poprzednik. Jeżeli nad warstwą, na 
której pracujesz nie ma pustej warstwy do wrzucenia nowego materiału,
to zostanie ona utworzona. Jeżeli w warstwie powyżej był jakiś klip lub 
klipy to zawartość całej warstwy zostanie przeniesiona wyżej na kolejną 
nowoutworzoną.

Jeżeli wrzucanym elementem materiału nie jest gotowy klip, lecz 
sekwencja to ustawienie w niej markerów In/Out i pozycja głowicy nie będą 
bez znaczenia dla efektu końcowego.
Wszystkie uprzednio opisane operacje montażowe uzyskiwane przez 
dropzony odnoszą się do warstwy zaznaczonej jako docelowa w oknie 
Timeline.
W poniższym przykładzie warstwą docelową jest V2, aby to zmienić 
wystarczy kliknąć w przycisk z nazwą innej warstwy.

INFORMACJE CZASOWE (OVERLAYS)

Podczas pracy z oknami Viewer i Canvas na tle widocznego w nich materiału bywają wyświetlane 
informacje pozwalające na szybką informację w zakresie zdarzeń związanych z alokacją prezentowanej 
klatki obrazu względem linii czasu projektu, w ktory klip jest zastosowany, lub jego indywidualnej 
(szczególnie w oknie Viewer”. Na poniższym obrazku zaprezentowane są wszystkie jednocześnie (taka 
sytuacja nie zdarzy się raczej podczas normalnej pracy z programem).
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obwiednia (boundingbox / wireframe)
wskazująca rozmiar grafiki z klipu

uchwyt narożny pozwala: 
skalować (narzędzie Strzałka)
deformować (narzędzie Distort)

brzeg obwiedni
pozwala obracać
(narzędzie Strzałka)

obszar materiału 
potencjalnie
widocznego dla 
widza / odbiorcy

ścieżka ruchu
po niej będzie
przemieszczał 
się klip

znaczniki dynamiki
(nie pokazują one pozycji konkretnych klatek),
a jedynie mówią o zwiększaniu się prędkości
obiektu (gdy są w dużych odstępach) lub
spowalnianiu (gdy są blisko siebie)

“szachownica” mówiąca o transparentności 
materiału, jeśli tak ją pozostawimy, to po
wyrenderowaniu będzie tam barwa czarna

punkt korekcyjny (zaczep / uchwyt)
ciągnąc za niego zmieniasz przebieg krzywej

punkt korekcyjny dynamiki
ciągnąc za niego zmieniasz 
przyśpieszenie obiektu

margines 
techniczny
niewidoczny 
dla 
widza / odbiorcy

punkt węzłowy
będący klatką 
kluczową

punkt węzłowy
będący klatką 
kluczową

INNE WYŚWIETLANE ELEMENTY TECHNICZNE

Oprócz informacji o zdarzeniach związanych z alokacją czasową klipu, na podglądzie materiału wyświetlane 
bywają również inne elementy informujące nas o cechach klipu lub umożliwiające jego kontrolę.

OSTRZEŻENIA WYŚWIETLANE W MIEJSCU PODGLĄDU

Zdarzają się sytucaje, gdy zamiast niewielkich elementów informacyjnych wyświetlanych na tle grafiki 
z klipu. Cały klip lub cały obszar podglądu zastępowane są informacją 
o występującym problemie.

Na przykładzie po prawej widać tzw. niebieskie ostrzerzenie, informujące 
o tym, że materiał nie może zostać płynnie odtwarzany, gdyż nie został 
uprzednio wyrenderowany. Pojawia się ono zazwyczaj po kliknięciu w Play 
(lub spację z klawiatury) czy inny przycisk o podobnym działaniu 
(odtwarzający jakiś fragment materiału). Oznacza to, że materiał tworzący 
klip w danym miejscu jest zbyt złożony jak na możliwości Twojego sprzętu.
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Może zwierać zbyt wiele warstw wideo, zbyt dużo filtrów itd. by komputer był w stanie na bieżąco w czasie 
realnym przeliczyć ich działanie i wyświetlić obraz wyjściowy. W celu rozwiązania tego problemu mamy dwa 
wyjścia (pomijając rozbudowę naszego stanowiska roboczego lub zakup lepszego sprzętu :-)
Możemy wyrenderować całość lub część kompozycji (polecenia w menu Sequence -> Render...), lub 
zmniejszyć nasze wymagania odnośnie jakości i płynności obrazu generowanego realtimowo przez 
komputer (lista opcji RT ww oknie Timeline). Oczywiście zawsze może się zdarzyć też, że stworzony projekt 
będzie zbyt złożony do wyświetlania. Wtedy pozostaje nam tylko wyrenderowanie obrazu przed jego 
obejrzeniem. Więcej na ten temat znajdziesz w sekcji dotyczącej okna Timeline.

Drugie “czerwone” ostrzerzenie informuje o problemie
z materiałem źródłowym. Oznacza on wykryty brak 
możliwości dostępu do pliku z filmem czy grafiką.
Może być to spowodowane tym, że plik został 
przypadkowo usunięty, przeniesiony w inną lokację, 
a może nastąpiła tylko zmiana jego nazwy, lub nazwy
któregoś z elementów (nośnik, folder) w ścieżce dostępu.
Jeżeli sytuacja ta jest faktycznie błędem (a nie działaniem 
planowanym bo np: pracujecie w grupie roboczej i osoba
odpowiedzialna za retusz zdjęcia np: na chwilę usunęła 
plik o tej nazwie z dysku sieciowego, by podmienić go na 
jego ulepszoną wersję), najlepiej od razu spróbować 
odkryć przyczynę problemu i wyeliminować go.
W tym celu na początku zerknij do okna Browser
do zakładki gdzie trzymasz elementy składowe swojego projektu. Zagubiony plik powinien być oznaczony 
poprzez czerwone przekreślenie (który to plik? jego nazwa powinna być widoczna na planszy ostrzeżenia 
poniżej słów Media Offline) jak na przykładzie obok.
Jak naprawić problem. Upewnij się czy plik fizycznie jest 
dostępny (nie wyjąłeś omyłkowo np: zawierającej go płyty 
DVD z napędu, czy nie odłączyłeś pamięci USB, czy nie 
“poznikały” jakieś dyski sieciowe,...). Następnie kliknij na 
jego przekreślonej ikonce prawym klawiszem myszy 
i wybierz z menu kontekstowego polecenie Reconnect Media... zobaczysz wtedy okno takie jak na obrazku 
obok. Jest ono podzielone na dwie główne sekcje. Górna (Files To Connect) zawiera listę zagubionych 
plików, zaś dolna (Files Located) odnalezionych. Aby
ponownie połączyć zagubiony plik z klipem znajdującym 
się w projekcie należy kliknąć w Locate... (jeżeli wiesz

 
gdzie się on znajduje lub jak się aktualnie nazywa) lub Search... (jeżeli dopiero należy go odszukać).
Po kliknięciu w Locate zobaczymy okno (obrazek powyżej lewy), w którym możemy wskazać zagubiony 
plik. Kiedy plik (lub pliki) z górnej tabelki okna Reconnect Files przeskoczyły do dolnej (z listą 
odnalezionych) - pozostaje kliknąć w Connect.
W oknie Browsers z ikonek uprzednio zaginionych plików winny poznikać czerwone przekreślenia.
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tymczasowe wyciszenie

wyciszenie

zoom (w osi czasu) 
zawartości okna

uchwyt zoomujący

przycisk Auto Select
pozwala np: zaznaczyć warstwy
wideo / audio do jednoczesnego
zastosowania efektu bez
indywidualnej selekcji klipów

zaciemnione obszary klipów
audio i wideo znajdują się poza
obszarem selekcji (zaznaczenia
z użyciem markerów In i Out)

krzywa regulacji poziomu
wzmocnienia dźwięku
(wyżej = głośniej)
pozwala na wyciszenie
(od 100% natężenia do 0%)
lub podgłośnienie (do 150%)

panel warstw wideo

regulator jakości podglądu

zakładki sekwencji znacznik In znacznik Out

znaczniki edycyjne

wirtualna głowica magnetowidu
warstwa zablokowana oznaczona
ukośnym szrafunkiem

informacja o stanie wyrenderowania lub gotowości podglądu
/ odsłuchu materiałów w projekcie (górna linia dotyczy 
wideo, zaś dolna audio)

listwa czasowa krzywa transparentności

panel warstw
audio

linia dzieląca panele
dla audio i wideo
można ją przeciągać
góra / dół

Snapping powoduje
doprecyzowanie
działań odręcznych
(myszką) do najbliższych
elementów kompozycji

synchronizacja audio i wideo
pochodzącego z jednego klipu

okno timecodów
widać tu bieżącą pozycję czasową

wirtualnej głowicy magnetowidu
pole to można też edytować

odsyłając głowicę do żądanej pozycji

regulator wysokości warstw
niższych mieści się więcej w oknie

na wyższych wyraźniej widać
podgląd zawartości i precyzyjniej 

reguluje się kształt krzywej

analogicznie jak regulator wysokości warstw
dodatkowo pozwala włączyć wyświetlanie

diagramu (waveform) natężenia sygnału audio
jak i regulować podgląd w warstwach wideo

(pojedyńczy obrazek lub “taśma filmowa”)

ukazuje i chowa krzywe
transparentności i wzmocnienia

ukazuje i chowa
przyciski tymczaso-

wego odsłuchu
i wyciszenia

widoczność warstwy

znacznik docelowej warstwy

przycisk blokady warstwy

tymczasowy
odsłuch

OKNO TIMELINE

Okno Timeline znajduje się zazwyczaj w dolnej połowie ekranu i jest swego rodzaju odpowiednikiem palet 
Layers (Warstwy) z programów takich jak Photoshop czy Illustrator, z tym jednak istotnym zastrzeżeniem, 
że o ile oba w/w programy pracują zazwyczaj na jednym nieruchomym obrazie (jak jedna klatka materiału), 
to Final Cut owych klatek “zużywa” nie mniej niż 25 na sekundę. Istotną różnicą też jest fakt, że warstwy 
w FCE nie mogą być przenoszone na wyższe lub niższe pozycje (ich zawartość można tak przenosić).
Dzięki temu poprzez montaż na różnych poziomach elementów wideo i grafiki zawierających obszary 
przezroczystości, możemy budować wirtualny “świat” w oparciu o zasadę perspektywy kulisowej (podobnie 
jak w wcześniej wymienionych AI i PS). Oczywiście programy takie jak Final Cut, Premiere i inne aplikacje 
montażowe, mają pewne ograniczenia w zakresie prac kompozycyjnych czy FX (w wypadku bardziej 
złożonych zadań, badziej przydatne mogą być aplikacje takie jak: Motion, Shake, AfterEffects,...).

W oknie tym odbywa się większość działań związanych z montażem. Do niego możesz przeciągać Klipy 
audio i wideo (i generatory) z okien Browser i Viewer. Następnie na w/w klipy możesz z zakładki Effects (też 
z okna Browser) przeciągać filtry, lub pomiędzy nie przejścia (Transitions). Wszystko poprzez drag and drop.
Tutaj również przy użyciu odpowiednich narzędzi (wybieranych w palecie Tools) możesz dokonywać 
selekcji, przycinać lub rozwijać materiał, regulować jego transparentność (wideo) czy głośność. Tu również 
poprzez regulację pozycji znacznika warstwy docelowej (Source) możesz określać  na co będzie wpływał 
montaż z użyciem dropzonów lub przyciskami Auto Select dokonywać masowych selekcji (lub wyklczeń)

Apple Final Cut Express 4 QuickStart © Jakub Balicki 2010          strona 16



przed masowym zastosowaniem modyfikatorów (poprzez menu Effects). Tu znajdują się też indyktatory 
(w postaci kolorowych pasków nad listwą czasu) wyrenderowania (lub gotowości do podglądu) 
realizowanego materiału, oraz menu RT pozwalające określić nasze wymagania odnośnie w/w podglądu.

MENU RT W OKNIE TIMELINE

W trakcie montażu będziesz wielokrotnie potrzebował obejrzeć (odsłuchać) całość lub część obrabianego 
materiału by kontrolować poprawność dokonywanych zmian. W tym celu odtworzyć materiał. Jednak gdy 
projekt lub jego fragment jest zbyt skomplikowany (wiele warstw, nadanych 
efektów, zdarzeń związanych z ruchem, skalowaniem, rotacją itd.) komputer 
nie jest w stanie na bieżąco odtwarzać materiał jednocześnie stosując na 
nim użyte efekty itd. Oczywiście materiał (w całości lub tylko obrabianym 
fragmencie) można zawsze przeliczyć (Render) do podglądu odsłuchu.
Jednakże każdorazowe renderowanie (po nawet delikatnych zmianach)
powoduje duże spowolnienie pracy (więcej czeka się na realizację zadania
przez komputer niźli faktycznie pracuje kreacyjnie). Powodowane jest to
koniecznością przeliczenia dużej ilości danych by uzyskać finalnie obraz 
pełnej jakości. Nie zawsze jest on jednak potrzebny do sprawdzenia decyzji 
w procesie montażu. Przykładowo jeżeli pracujesz na stanowisku z jednym 
monitorem, to nawet w wypadku materiału SD nie wykorzystujesz 
do podglądu pełnej jego rozdzielczości (skala w oknie Canvas mniejsza niż
100%). W menu RT (RT od Rael Time) możesz określić zgrubnie (Safe RT
daje lepszą, zaś Unlimited RT gorszą jakość, Play Base Layer Only ogranicza 
podgląd do wybranej warstwy) swoje wymagania jakościowe, lub też 
wybiórczo określić redukcję rozdzielczości obrazu (High, Medium, Low),
czy ilości wyświetlanych klatek (Full, Half, Quarter). Możesz też wybrać 
opcję, w której program sam spróbuje wygenerować w czasie rzeczywistym
podgląd na tyle dobrej jakości, na ile pozwala wydajność komputera na którym jest uruchomiony. Jeżeli 
chcesz analogicznie określić jakość podglądu generowanego poleceniami Render skorzystaj z menu 
Sequence -> Settings. W oknie Sequence Settings w zakładce Render Control znajdziesz podobną 
możliwość regulacji, powiększoną o opcje wyłączenia renderowania filtrów i mieszania klatek (domyślnie 
uaktywnione przy regulacji prędkości klipu poleceniem Speed, celem wygładzenia ruchu w sytuacjach Slow 
Motion).

NARZĘDZIA SELEKCJI

Podczas pracy z oknem Timeline i widocznymi w nim klipami tworzącymi kompozycję wideo niezbędna jest 
znajomość różnych sposobów na wskazywanie, które elementy (i czasami w jakim zakresie) mają ulec 
przemieszczeniu, modyfikacji, przycięciu czy też zostaną usunięte z sekwencji. W tym celu można 
korzystać (w podstawowym zakresie) z narzędzia selekcji czyli Strzałki. Jednakże jej możliwości są dość 
ograniczone, wtedy pomocne mogą być specjalizowane narzędzia selekcji.

Pierwsze z nich (Edit Selection Tool) pozwala zaznaczać końce / początki klipów celem ich 
późniejszego przemieszczenia (trzymasz Shift i naciskasz jeden z nawiasów prostokątnych).
Zwróć uwagę, że pozostałe zakończenie klipów nie przemieszczają się, więc jeśli jakiś klip 
“wydłużasz” to do sekwencji wchodzą klatki wcześniej pozostające poza markerem końca
lub początku klipu.

Selekcja grupowa pozwala zaznaczać wiele klipów jednocześnie, nie zakreślając ich całych
w obszar selekcji prostokątnej (jak to robi Strzałka). Wystarczy zaznaczyć choć maleńki 
kawałek i wtedy zaznaczamy cały klip.

Gdy w przeciwieństwie do poprzedniego narzędzia chcemy dokonać edycji części mniejszej 
niż co najmniej jeden klip na Timelinie. Wtedy posługując się narzędziem selekcji 
fragmentarycznej (poprzez przeciągnięcie wewnątrz reprezentanta klipu można zaznaczyć 
jego część.
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Inne narzędzia pozwalające na masową 
selekcję klipów na Timeline (wybierasz je
naciskając klawisz T) pozwalają po kliknięciu 
w klip zaznaczyć go wraz z innymi klipami
znajdującymi się w stosunku do niego
(patrząc na ikonki narzędzi od lewej): wszystkich następujących w jego warstwie; wszystkich 
poprzedzających w jego warstwie; wszystkich w jego warstwie; wszystkich następujących; wszystkich 
poprzedzających. Dotyczy to oczywiście niezablokowanych elementów kompozycji.

Kiedy została dokonana już selekcja materiału, na którym należy wprowadzić zmiany - pomocne mogą tu 
być kolejne narzędzia. Ponieważ interfejs programu FCE ma z założenia przypominać analogowy stół 
montażowy, na którym pracowało się na światłoczułej, a potem magnetycznej taśmie - jego narzędzia też 
będą ową teraz już wirtualną taśmę zwijać, rozwijać czy też przycinać.

Pozwala zwijać i rozwijać materiał klipu w oknie Timeline. Umożliwia działanie zarówno 
na początku jak i na końcu samotnego klipu. Pozwala też regulować jednocześnie punkt styku 
dwóch klipów poprzez jednoczesne zwijanie klipu A i rozwijanie klipu B.
Podczas tego (i analogicznych działań edycyjnych) zawartość okna Canvas zmienia się tak by 
informować o cechach nowego przycięcia czy połączenia. Oferuje wtedy podglądy zawartości klipów 
zarówno w postaci wyświetlania grafiki w miejscu edycji, jak i nałożonych na nią informacji o czasie 
i piktogramu informującego czy klatka kończy / rozpoczyna selekcję użytą z w/w materiału (znacznik In / 
Out), patrz obrazek poniżej.

Działa podobnie do narzędzia opisanego powyżej, jednak w trakcie zwijania / rozwijania jednego
z zakończeń klipu, powoduje analogiczną (lustrzaną zmianę) na drugim końcu klipu (czyli 
jednoczesne zwijanie lub rozwijanie z obu stron).

Nie zmieniając pozycji zakończeń klipu (In / Out) względem osadzenia w Timeline, powoduje
przewinięcie zawartości materiału w klipie wewnątrz tych (In / Out) znaczników. W oknie Canvas 
analogicznie do poprzednich sytuacji widzimy podgląd nowego początku i końca.

Działa sensownie gdy nasz klip otoczony jest z dwóch stron na styk innymi. Pozwala wtedy 
przemieszczać nasz klip w osi czasu do przodu (w przyszłość) i wstecz powodując jednoczesne 
odpowiednie zwijanie i rozwijanie klipów sąsiadujących. Muszą one jednak posiadać odpowiedni 
zapas czasu. Ich znaczniki In / Out nie mogą być równe ich końcom. Gdy owego “nadmiaru 
taśmy” w klipach sąsiadujących zabraknie, to mimo dalszego przeciągania myszą - nasz podstawowy 
edytowany klip przestanie się przemieszczać.

Narzędzie Żyletka pozwala przecinać klipy audio i wideo, przy czym narzędzie z ikoną 
dwóch żyletek tnie wszystkie (niezablokowane) klipy na całej wysokości Timelin-u, zaś
 to z pojedyńczą, edytuje wyłącznie klip na ktorym zostało użyte.
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NARZĘDZIA KONTROLI WIDOKU

Pozwalają na przybliżanie i oddalanie (w oknach Canvas i Viewer) wyświetlanej 
grafiki. Analogicznie w Viewerze w zakładkach dotyczących audio regulują 
precyzję wyświetlanego waveformu. W wypadku okna Timeline pozwalają na 
zawężanie (lub na odwrót) prezentowanego zakresu czasowego obrabianej 
kompozycji.

Pozwalają również (po zastosowaniu zbliżenia) przemieszczać zawartość 
okna (analogicznie jak narzędzie o tej ikonie w Illustratorze czy Photoshopie).

Przy użyciu zmodyfikowanego narzędzia Scrub możesz przewijać zawartość 
okien podglądu na reprezentantach klipów w oknie Timeline jak i analogicznie 
przewijać “taśmę” w plikach wideo w Browserze w zakładce projektu (ale tylko 
w innych widokach niż lista). Pozwala to zorientować się szybko w zawartości graficznej pliku, jak 
i w wypadku okna Browser - pozostawić jako ikonkę - najbardziej charakterystyczny dla danego klipu widok 
(przytrzymaj klawisz Control zanim puścisz klawisz myszy).

NARZĘDZIA KONTROLI KRZYWYCH

Działają one prawie analogicznie (w połączeniu z narzędziem Strzałka) jak ich 
odpowiedniki w programach graficznych firmy Adobe. W programie FCE są one 
stosowane do modelowania krzywej sterującej atrybutami filtrów, poziomem 
głośności, transparentności, położenia obiektu czy dynamiki jego 
przemieszczania. Pierwsze z nich (od lewej) po kliknięciu na krzywej dodaje na niej punkt węzłowy, zaś po 
jego pociągnięciu pozwala go przemieszczać (kursor zmieniony w krzyżyk). Pozwala też chwytać za punkty 
korekcyjne (zaczepy / uchwyty) sterujące wygięciem krzywej i dynamiką duchu (to ostatnie wyłącznie 
w oknach Canvas i Browser).
Kolejne z narzędzi (stalówka z “minusem”) po kliknięciu na punkcie węzłowym kasuje go.
Ostatnie z nich pozwala dodawać punkty korekcyjne do punktu węzłowego by modelować krzywą 
o płynnym kształcie (a nie zygzakowatym), lub po ponownym kliknięciu kasuje je.
Zwróć uwagę, że gdy punkt węzłowy posiada punkty kontrolne, to gdy poruszasz za jeden z nich, to drugi 
przemieszcza się analogicznie zapewniając maksymalnie płynny przebieg krzywej przez punkt. Jeżeli jednak 
potrzebujemy uzyskać załamanie w linii przebiegu krzywej należy uczynić co następuje. Wybrać narzędzie 
Strzałki (Selection Tool). W trakcie przeciągania za punkt kontrolny wciskać i trzymać klawisz Command 
(CMD / “Jabłko”). Najpierw zwolnić klawisz myszy, a potem ten na klawiaturze.

TWORZENIE I EKSPORT MATERIAŁU Z ZNACZNIKAMI ROZDZIAŁÓW

Gdy chcesz aby twój projekt mógł być oglądany w QuickTime Playerze lub przetworzony w programach 
takich jak Apple DVD Studio Pro czy Apple iDVD z wykorzystaiem rozdziałów (Chapters). W tym celu 
podczas pracy na sekwencji zawierającej finalną postać projektu należy dodać znaczniki rozdziałów 
poprzez: ustawienie głowicy magnetowidu w odpowiednim momencie na osi czasu; wybranie w menu 
polecenia Mark -> Markers -> Add; należy kliknąć w przyciski Add Chapter Marker, a następnie w OK.
W tej chwili materiał posiada już odpowiedni znacznik / znaczniki. Należy go przeliczyć (Sequence -> 
Render All) i uważnie obejrzeć celem wychwycenia 
ewntualnych błędów do poprawy (potem już będzie za późno).
Celem wyeksportowania należy wybrać z menu File -> Export 
-> QuickTime Movie... w pojawiającym się oknie dialogowym 
Save na dole znajduje się rozwijane menu wyboru “Markers” 
należy wskazać typ markerów przeznaczonych do zapisu 
(w wypadku eksportu na potrzeby iDVD wybierz Chapter 
Markers).
Warto też sprawdzić czy zaznaczone jest Make Movie Self 
Contained.
Teraz już tylko naciśnięcie przycisku Save oddziela nas 
od otrzymania pliku w kontenerze multimedialnym MOV 
z materiałem zapisamym w kodeku domyślnym dla 
eksportowanej sekwencji.
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obecność i czas trwania
planszy kontrolnej

i sygnału audio

sekcja dodatkowej
ewentualnej automatycznej

tytułówki

zakres eksportu materiału 
In to Out (w zakresie znaczników)

lub całość,
ewentualne kilkukrotne zapętlenie

wraz z ilością czerni pomiędzy
powtórzeniami

łączny czas trwania materiału
wraz z elementami 
technicznymi

czas trwania materiału 
właściwego

ile sekund czerni na końcu 
materiału

ZGRYWANIE MATERIAŁU NA TAŚMĘ

Gdy nasz projekt jest ukończony i chcemy przegrać go na taśmę, warto rozpocząć od następujących 
kroków. Przede wszytkim upewnij się, że w oknie Timeline lub Canvas zakładka z sekwencją zawierającą 
materiał do zgrania jest na samym wierzchu, a jedno z tych okien jest zaznaczone (jego pasek z nazwą jest 
jaśniejszy od tych na pozostałych oknach). Dla pewności wybierz polecenie Sequence -> Render All -> 
Booth. Komputer przeliczy materiał audio i wideo (jeśli wcześniej tego nie robił). Pamiętaj, że rendering 
złożonego materiału (nawet na szybkim sprzęcie) może trwać znacznie dłużej niż jego czas emisyjny.
Odtwórz cały materiał w oknie Canvas przy powiększeniu 100%. Sprawdź czy wszystko jest OK.
Upewnij się, że masz do komputera podłączony przez port IE1394/FireWire odpowideni sprzęt. Czyli 
magnetowid cyfrowy lub kamerę DV (musi być włączona w trybie VCR) z możliwością importu/eksportu 
materiału (DV in/out) lub konwerter cyfrowo analogowy i magnetowid analogowy (najlepiej dodatkowo 
podłączone kablem LANC, jeżeli twój sprzęt nie obsługuje LANC-a wtedy będziesz musiał ręcznie naciskać 
przyciski na magnetowidzie przewijając, stopując czy włączając Record). 
Wybierz w menu File polecenie Print to Video... pojawi się okno nastaw eksportu takie jak poniżej.

Jeżeli zgrywany materiał będzie przeznaczony do emisji, czy dalszego montażu warto dodać do niego 
sygnał kontrolny (Color Bars itd.). W wypadku zastosowań typowo domowych można to sobie ewentualnie 
odpuścić.
Gdy klikniemy OK program spyta się czy wszystko jest przygotowane (jeżeli nagrywasz na sprzęt 
analogowy bez LANC-a lub na niewpełni obsługiwany sprzęt cyfrowy, jest to właśnie ten moment, w którym 
warto wcisnąć na takim urządzeniu Record).

Następnie klikasz OK po czym powinieneś zobaczyć na ekranie (na czarnym tle) kolejno wszystkie elementy 
nagrywanego materiału. Warto sprawdzić czy na podglądzie kontrolnym urządzenia rejestrującego 
(np: ekranie LCD kamery wideo) widać dokładnie to samo (może występować opóźnienie pomiędzy 
komputerem, a kamerą/magnetowidem - to normalna sytuacja). Po zakończeniu eksportu materiału, znów 
będzie widoczny standardowy interfejs programu. Kamera/magnetowid sterowana przez DV lub LANC 
powinna zatrzymać się automatycznie. Na urządzeniu nieobsługiwanym w ten sposób należy nacisnąć 
Stop.
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